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Partial Reconfiguration Tutorial
This tutorial demonstrates how to create a simple partial reconfiguration (PR) design from H ardw are
Description Language (H DL) synthesis through BIT file generation and dow nload. Xilinx® softw are tools
are used to implement and analyze the design through the PlanA head™ softw are. Other tools, such as
CORE Generator™ and ChipScope™ Pro, can be used w ith a partial reconfiguration design, but are not
described in this tutorial.
To benefit from this tutorial, you must be familiar w ith partial reconfiguration, and have experience
implementing an FPGA design w ith Xilinx softw are.
This tutorial covers only a subset of the features in the PlanA head softw are. A dditional features are
covered in other tutorials.
A fter completing this tutorial, you w ill be able to set up, run, and manage a partial reconfiguration
project using the PlanA head softw are. Specifically, you w ill learn how to:
•

Create a reconfigurable partition (RP).

•

A dd a reconfigurable module (RM ).

•

Define Pblock ranges for the reconfigurable partitions.

•

Run pr-specific DRC checks.

•

Create and implement configurations.

•

Verify configuration.

•

Generate bit files.

Software Requirements
®

The PlanA head softw are installs w ith the ISE Design Suite softw are. Before starting the tutorial, ensure
that the PlanA head softw are is operational, and that the tutorial design data is installed.
For installation instructions and information, see the ISE Design Suite: Installation and Licensing Guide
(UG798) at http:/ / w w w .xilinx.com/ support/ documentation/ sw _manuals/ xilinx13_3/ iil.pdf.

Hardware Requirements
Xilinx recommends a minimum of 2 GB of RA M w hen using the PlanA head softw are on larger devices.
A lthough 1 GB is sufficient, it can impact performance.

Tutorial Design Files
This tutorial uses a reference design, UG743_design_files.zip, w hich must be unzipped to a w riteaccessible directory. You can dow nload a copy of the reference design from
http:/ / w w w .xilinx.com/ support/ documentation/ dt_planahead_planahead13-3_tutorials.htm.
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Tutorial Design Description
The unzipped data directory is referred to in this tutorial as <Extract_Dir>.
The tutorial sample design data is modified w hile performing this tutorial. A new copy of the original
data is required each time you run the tutorial.
This tutorial includes a project file that has already been implemented. To reduce the data size, some
implementation files w ere removed from the design, leaving only the required results data in the run
directories.

Tutorial Design Description
The FPGA design in this tutorial is targeted to the Xilinx M L605 prototype board described at
http:/ / w w w .xilinx.com/ ml605. The design targets a Virtex®-6 xc6vlx240tff1156-1 device. The FPGA
device drives the LEDs in particular sequences depending on w hich reconfigurable modules are loaded.
The design contains tw o reconfigurable partitions:
•

One reconfigurable partition contains embedded block RA M .
Reconfiguring the block RA M module w ith different block RA M data changes the LED sequence of
the eight GPIO LEDs.

•

One reconfigurable partition contains embedded I/ O buffers.
Reconfiguring the I/ O module w ith different state machine transitions changes the direction that the
four LEDs rotate, either clockw ise or counterclockw ise.

Tutorial Software Overview

Figure 1: Design Overview - Partial Reconfiguration
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Software Tools Flow

Software Tools Flow
Partial reconfiguration uses a bottom-up synthesis approach w ith top-dow n implementation
methodology. This tutorial uses the Xilinx Synthesis Technology (XST) to synthesize the design, and the
PlanA head softw are to implement the design. Other tools and methodologies can be used to successfully
implement a partial reconfiguration design.

Figure 2: Software Flow Overview
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Project Directory and HDL Design Structure

Project Directory and HDL Design Structure
A black box and bottom-up synthesis approach is required to correctly structure and synthesize a
partially reconfigurable FPGA design. Each reconfigurable module is synthesized as an individual project
generating its ow n netlist. Since the top-level design instantiates the reconfigurable modules as black
boxes, the reconfigurable module netlists are not included in the top-level netlist.
The directory structure of the tutorial design is:
<Extract_Dir>
- Implementation

->

-

->
->
->
->

Synth
PlanAhead
Source
Tools

Synthesis results (and implementation
results if scripted methodology used)
PlanAhead project and results
PlanAhead project and results
HDL source files and constraint files
Tcl scripts for command line flow (not covered
in this tutorial)

Because each reconfigurable module is synthesized independently, there is a directory for the top-level
module, as w ell as each reconfigurable module in the /Source and /Implementation Synth directories.
Implementation
Top (top level and all static logic)
BramFirst (first version of the BRAM RM)
BramSecond (second version of the BRAM RM)
CountCW (Clockwise version of the counter)
CountCCW (Counterclockwise version of the counter)

Open the top-level source file:
<Extract_Dir>/Source/Top/Top.v

The tw o reconfigurable modules in this design (recon_block_bram and recon_block_count) are
declared as black boxes in the H DL. N o underlying H DL descriptions are provided for these blocks.

Partial Reconfiguration Tutorial
UG747 (v 13.3) October 19, 2011

www.xilinx.com

8

Step 1: Synthesizing Netlists from HDL Source (Optional)

Step 1: Synthesizing Netlists from HDL Source (Optional)
Since the PlanA head softw are does not support H DL projects for the partial reconfiguration flow , you
must synthesize the design using XST before creating a PlanA head project. XST has already been run in
the files accompanying this tutorial. This allow s you to use the accompanying N GC files if you w ish. To
use the accompanying N GC files, skip to Step 2: Creating a Project.
The XST project files are:
•

<Extract_Dir>/Synth/Top/Top.xst

•

<Extract_Dir>/Synth/Top/Top.prj

In Top.xst, automatic I/ O buffer insertion is turned on by default. This attribute must be set to N O in
the XST project files for all reconfigurable modules.
-iobuf N O
Low er-level modules cannot have I/ O buffers inserted except in special circumstances. These
circumstances are described later, and are illustrated in the U2_RP_Count reconfigurable partition.

Running the Tcl Scripts to Synthesize All Modules
To synthesize all modules, run the follow ing command from the <Extract_Dir> directory.
tclsh ./Tools/xpartition.tcl ./Tools/data_synth.tcl

This script calls XST to synthesize the Verilog files in the source directories.
•

The modules in <Extract_Dir>/Source/Bram* have block RA M in the reconfigurable module.

•

The modules in <Extract_Dir>/Source/Count* have I/ O buffers in the reconfigurable module.

The N GC netlist files generated by XST are stored in the <Extract_Dir>/Synth/<module> directories.
If you prefer to use Synplify Pro, modify the data_synth.tcl file before running the above as follow s:
SYN TH _TOOL “synplify_pro” \
The Synplify Pro project files provided in the <Extract_Dir>/Synth/<module> directories are used
w hen this option is set.
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Step 2: Creating a Project

Step 2: Creating a Project
To create a new project:
1.

Open the PlanA head softw are.
•

In Window s, select Start > Programs > Xilinx I SE D esign Suite 13 > PlanAhead > PlanAhead.

•

In Linux, change the directory to <Extract_Dir>/planAhead, and enter planAhead.

2.

On the PlanA head Getting Started H elp page, select Create N ew Project.

3.

In the Create a N ew PlanA head Project dialog box, click N ext.

4.

In the Project N ame dialog box, set the project name and select the project location to be:
<Extract_Dir>/ planA head

5.

Click N ext.

6.

In the Design Source dialog box, select Specify Synthesized (ED I F or N GC) N etlist.

7.

Check the Enable Partial Reconfiguration box.

8.

Click N ext.

Figure 3: Specify Design Source
10. Click the Add Files button and brow se to the follow ing top-level netlist:
<Extract_Dir>/Synth/Top/Top.ngc

11. Click OK to add this file to the project.
Only files associated w ith the top-level (or Static) logic should
low er level, reconfigurable modules w ill be added later.
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Step 2: Creating a Project
12. Click N ext.
13. On the Constraint Files page, click Add Files.
14. Brow se to the follow ing User Constraints File (UCF):
<Extract_Dir>/Source/UCF/top_ml605.ucf

15. Click OK.
16. Click N ext.
The Default Part w izard scans the netlist and picks the appropriate device.
17. Verify that the selected device is xc6vlx240tff1156-1.
18. Click N ext.
19. On the N ew Project Summary page, verify the project settings.

Figure 4: New Project Summary
20. Click Finish.
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Step 3: Creating Reconfigurable Partitions and Adding Reconfigurable Modules

Step 3: Creating Reconfigurable Partitions and Adding
Reconfigurable Modules
This step includes:
•

Creating a Reconfigurable Partition for U1_RP_Bram

•

Creating a Reconfigurable Partition for U2_RP_Count

Creating a Reconfigurable Partition for U1_RP_Bram
M any of the features described in this tutorial are available only w hen the N etlist Design is open. If you
close the N etlist Design, or if you close and reopen the project, click N etlist Design in the Flow N avigator
to open the N etlist Design.
To create a reconfigurable partition for U1_RP_Bram:
1.

In the Flow N avigator, select N etlist D esign.
This loads the netlist into memory. Because you have not yet assigned any netlists to the
reconfigurable modules, the softw are displays a couple message about undefined instances.

Figure 5: Undefined Modules Warning
2.

Click OK to accept all messages about the black box modules.

3.

In the N etlist w indow , select U1_RP_Bram.

4.

Right-click.

5.

Select Set Partition.
This launches the Set Partition w izard.

Partial Reconfiguration Tutorial
UG747 (v 13.3) October 19, 2011

www.xilinx.com

12

Step 3: Creating Reconfigurable Partitions and Adding Reconfigurable Modules

Figure 6: Setting Partition and Reconfigurable Module
6.

Click N ext.

7.

Select is A Reconfigurable Partition if not already selected.

8.

Click N ext.

9.

N ame the reconfigurable module BramFirst.

10. Select N etlist Already Available For This Reconfigurable M odule if not already selected.
11. Click N ext.
12. For the Top N etlist File, brow se to and select:
<Extract_Dir>/Synth/BramFirst/recon_block_bram.ngc

13. Click OK.
14. Click N ext.
You can add optional netlist directories here if the reconfigurable module has low er-level netlists
associated w ith it. In this case, there are none.
15. Click N ext to bypass the optional constraint files screen.
You can add module-level constraint files here. In this case, there are none.
16. Verify the Set Partition Summary.
17. Click Finish.
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Step 3: Creating Reconfigurable Partitions and Adding Reconfigurable Modules
A reconfigurable partition has now been created for U1_RP_Bram, and there is one reconfiguration
module listed under this instance as show n the follow ing figure. A Pblock has also been created for this
instance, and can be seen in the Physical Constraints w indow .

Figure 7: Reconfigurable Module "BramFirst"

Creating a Reconfigurable Partition for U2_RP_Count
To create a reconfigurable partition for U2_RP_Count:
1.

Select U2_RP_Count from the N etlist w indow .

2.

Right-click.

3.

Select Set Partition.

4.

Select is A Reconfigurable Partition if not already set.

5.

N ame the reconfigurable module CountCW.

6.

Select N etlist Already Available For This Reconfigurable M odule if not already set.

7.

Set Top N etlist File to:
<Extract_Dir>/Synth/CountCW/recon_block_count.ngc>

8.

Click N ext until the Summary page is presented.

9.

Click Finish to complete the w izard.

There is now one reconfigurable module for each reconfigurable partition. Step 4: Adding Additional
Reconfigurable M odules describes how to add additional reconfigurable modules for a reconfigurable
partition.
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Step 4: Adding Additional Reconfigurable Modules

Step 4: Adding Additional Reconfigurable Modules
This step includes:
•

A dding a Reconfigurable M odule to U1_RP_Bram

•

A dding a Reconfigurable M odule to U2_RP_Count

N ote that adding a new reconfigurable module is almost identical to creating the reconfigurable partition
and adding the first reconfigurable module.

Adding a Reconfigurable Module to U1_RP_Bram
To add a reconfigurable module to U1_RP_Bram:
1.

Go to the N etlist w indow .

2.

Select U1_RP_Bram.

3.

Right-click.

4.

Select Add Reconfigurable M odule.

Figure 8: Adding a Reconfigurable Module
5.

Click N ext on the A dd Reconfigurable M odule w izard.

6.

N ame the new reconfigurable module BramSecond.

7.

Click N ext.

7.

Set Top N etlist File to:
<Extract_Dir>/Synth/BramSecond/recon_block_bram.ngc.

8.

Click N ext until the summary page is presented.

9.

Click Finish to complete the w izard.

Adding a Reconfigurable Module to U2_RP_Count
To add a reconfigurable module to U2_RP_Count:
Partial Reconfiguration Tutorial
UG747 (v 13.3) October 19, 2011

www.xilinx.com

15

Step 4: Adding Additional Reconfigurable Modules
1.

Select U2_RP_Count.

2.

Right-click.

3.

Select Add Reconfigurable M odule.

4.

N ame the new reconfigurable module CountCCW.

5.

Set Top N etlist File to:
<Extract_Dir>/Synth/CountCCW/recon_block_count.ngc>

6.

Complete the Wizard.

One additional reconfigurable module has now been added to each reconfigurable partition. The netlist
w indow should resemble the figure below .
N ets and primitives specific to the currently-active reconfigurable module are listed under each
reconfigurable partition. They are signified by a yellow diamond w ith a check mark.
In the figure below , the active modules are BramFirst and CountCW.

Figure 9: Netlist Window After Adding Reconfigurable Modules

Changing the Active Reconfigurable Module
To change the active reconfigurable module to a different reconfigurable module:
1.

Select a reconfigurable module.

2.

Right-click.
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Step 4: Adding Additional Reconfigurable Modules
3.

Select Set as Active Reconfigurable M odule.

Primitives Associated with Reconfigurable Modules
The resources for each reconfigurable module can be seen under the Primitives folder in the N etlist
w indow . Depending on w hich RM is active, the resources w ill change. The follow ing resources are used
by the current active RM s.
•

A RA M B36 and an inverter for the reconfigurable module associated w ith U1_RP_Bram

•

Slice logic (LUT, XORY, and FDR) and OBUF primitives for the module associated w ith U2_RP_Count

The OBUF and RA M B36 primitives must be included in the A rea Group Range constraints for the
associated reconfigurable partition. This is show n in Step 6: Floorplanning Reconfigurable Partitions.
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Step 5: Adding Black Box Modules (Optional)

Step 5: Adding Black Box Modules (Optional)
The purpose of creating a black box module is to generate a blanking BIT file in the BitGen step.
This step includes:
•

A dding a Black Box M odule to U1_RP_Bram

•

A dding a Black Box M odule to U2_RP_Count

Adding a Black Box Module to U1_RP_Bram
To add a black box module to U1_RP_Bram:
1.

Select U1_RP_Bram.

2.

Right-click.

3.

Select Add Reconfigurable M odule.

4.

N ame the new reconfigurable module BramBB.

5.

Select Add This Reconfigurable M odule As A Black Box Without A N etlist.

6.

Click N ext.
Because there is no netlist or constraint file associated w ith a black box module, the w izard does not
prompt you for information.

7.

Click Finish.

Adding a Black Box Module to U2_RP_Count
To add a black box module to U1_RP_Bram:
1.

In the N etlist w indow , select U1_RP_Bram.

2.

Right-click.

3.

Select A dd Reconfigurable M odule.

4.

Set Reconfigurable M odule N ame to CountBB.

5.

Select Add This Reconfigurable M odule As A Black Box Without A N etlist.

6.

Finish the w izard.

One black box module now appears under each reconfigurable partition in the netlist w indow as show n
in the figure below .
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Step 5: Adding Black Box Modules (Optional)

Figure 10: Netlist Window with Black Box Modules
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Step 6: Floorplanning Reconfigurable Partitions

Step 6: Floorplanning Reconfigurable Partitions
Each reconfigurable partition must have an AREA_GROUP RANGE constraint to designate w hich physical
resources are part of the reconfigurable partition. In this example, the reconfigurable partitions are
U1_RP_Bram and U2_RP_Count.
A ll physical resources not part of the AREA_GROUP RANGE constraint associated w ith a reconfigurable
partition are part of the static logic. Static logic is unaffected by partial reconfiguration, and remains
operational during reconfiguration. Refer to the Partial Reconfiguration User's Guide for more
information on the affects of active logic during partial reconfiguration, and the use of decoupling logic.
Do not create the AREA_GROUP Range constraints until the reconfigurable partitions have been created
w ith the Set Partition command as described in Step 3: Creating Reconfigurable Partitions and Adding
Reconfigurable M odules.

Creating the AREA_GROUP Range for pblock_U1_RP_Bram
To create the A REA _GROUP Range for pblock_U1_RP_Bram:
1.

In the N etlist w indow , verify that BramFirst and CountCW are the active modules.
A ctive modules are indicated by a check mark next to the module name.

2.

If BramFirst and CountCW are not the active modules:
a) Select BramFirst and CountCW.
b) Right-click.
c)

Select Set As Active Reconfigurable M odule.

The PlanA head softw are reports the required resources for the AREA_GROUP Range for the active
reconfigurable module. Be sure that a black box reconfigurable module is not active.
For situations in w hich different reconfigurable modules associated w ith a reconfigurable partition
use various resources, the AREA_GROUP range of the reconfigurable partition must contain a superset
of resources used by all its reconfigurable modules.
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Step 6: Floorplanning Reconfigurable Partitions

Figure 11: Setting Active Reconfiguration Modules
3.

Click Layout on the toolbar.

4.

Select Floorplanning to change the current view from Design A nalysis to Floorplanning.
The Physical Constraints w indow show s a list of all the current Pblocks.
In the PlanA head softw are, AREA_GROUP constraints are called Pblocks. Pblocks are automatically
created for any modules defined as a reconfigurable partition.

5.

In the Physical Constraints w indow , select the Pblock named pblock_U1_RP_Bram.

6.

On the left-hand side of the Device view , click Set Pblock Size icon (

).

N ote that a Pblock must be selected for this icon to be present.
7.

Draw a box that encompasses some slice logic and at least one RAMB36 (pink columns).

8.

A fter draw ing the box, select both SLICE and RAMB36 resources for the AREA_GROUP.
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Step 6: Floorplanning Reconfigurable Partitions

Figure 12: Setting Pblock Resources pblock_U1_RP_Bram
9.

Click OK.

Creating an AREA_GROUP Range for pblock_U2_RP_Count
To create an AREA_GROUP range for pblock_U2_RP_Count:
1.

Select pblock_U2_RP_Count.

2.

Use the Set Pblock Size tool to draw a box that encompasses slice resources and IOB logic.
Because U2_RP_Count already has I/ O pin placement in the UCF, the AREA_GROUP range must
include the follow ing pins, w hich are visible in the floorplan:

3.

•

A D21

•

A H 27

•

A E21

•

A H 28

A fter draw ing the rectangle, select SLICE and IOB resources for the A rea Group.
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Step 6: Floorplanning Reconfigurable Partitions

Figure 13: Setting Pblock Resources -- pblock_U2_RP_Count
4.

Click OK.
If the reconfigurable module has input or output flip-flops (or any other input or output logic), other
resources such as ILOGIC and OLOGIC are also included. The design in this tutorial does not contain
any such resources.

5.

Review the floorplan and make any necessary adjustments.
The resulting floorplan w ill resemble the follow ing figure.
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Step 6: Floorplanning Reconfigurable Partitions

Figure 14: Final AREA_GROUP Ranges
6.

Verify that the pins required for U2_RP_Count are w ithin the AREA_GROUP range.
The pins A D21, A H 27, A E21, and A H 28 must be included in the rectangle of the AREA_GROUP range
for U2_RP_Count. See the figure above.
A lso, note the rectangle extends to the right of the I/ O column. The I/ O routing resources on the
right side of this I/ O column must be included in the AREA_GROUP range, or the router w ill fail
implementation. A ll reconfigurable module routing resources must be w ithin the reconfigurable
partition region as defined by the AREA_GROUP RANGE.

7.

To locate these pins in the Device view in order to verify that they are inside the AREA_GROUP range:
a) Select Edit > Find.
b) Search for Site with N ame matches AD 21.
c)

The pin is highlighted in the Device view because the UCF already contains a LOC constraint.

d) Select V iew > Fit Selection to zoom to the highlighted site.
e) Follow the same procedure to find the AH27, AE21, and AH28 pins.
8.

Verify that the RA M B36 required for U1_RP_Bram is included in the AREA_GROUP range.
a) In the Physical Constraints w indow , select pblock_U1_RP_Bram.
b) Click the Statistics tab.
In this instance, the available number of RAMBFIFO36E1 exceeds the required amount.
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Step 6: Floorplanning Reconfigurable Partitions

Figure 15: Pblock Statistics -- pblock_U1_RP_Bram
10. Select File > Save D esign.
11. In the Flow N avigator, click Project M anager.
The Sources w indow opens show ing all the source and constraint files.
12. Under Constraints, double-click the UCF file.
The AREA_GROUP constraints are similar to the follow ing.
INST “U1_RP_Bram” AREA_GROUP = “pblock_U1_RP_Bram”;
AREA_GROUP “pblock_U1_RP_Bram” RANGE=SLICE_X48Y60:SLICE_X55Y79;
AREA_GROUP “pblock_U1_RP_Bram” RANGE=RAMB36_X3Y12:RAMB36_X3Y15;
INST “U2_RP_Count” AREA_GROUP = “pblock_U2_RP_Count”;
AREA_GROUP “pblock_U2_RP_Count” RANGE=SLICE_X56Y20:SLICE_X67Y79;
AREA_GROUP “pblock_U2_RP_Count” RANGE=IOB_X1Y20:IOB_X1Y79;

13. Return to the N etlist Design view .
14. Click Layout.
15. Select D esign Analysis to revert to the default view in the PlanA head softw are.
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Step 7: Partition Pins and Reconfigurable partition Interface Timing

Step 7: Partition Pins and Reconfigurable partition Interface
Timing
Partition pins are required in the partial reconfiguration flow for all reconfigurable partition interface
signals that are not global logic or dedicated routes. Partition pins provide a know n routing connection to
the reconfigurable partition. They are automatically inserted by N GDBuild w hen implementation is run.
These are a replacement technology for bus macros from the previous partial reconfiguration flow .
The current implementation of partition pins requires proxy logic (a LUT1). A LUT1 is inserted in the
input and output paths of the reconfigurable partition. Xilinx recommends that you register these inputs
and outputs on both sides of the reconfigurable partition boundary. Registering these inputs helps
minimize any timing closure issues related to the reconfigurable partition interface.
If these guidelines are follow ed, it is likely that a simple PERIOD constraint is enough to constrain this
interface. H ow ever, in situations w ith tight timing requirements, you might need to:
•

Create TPSYN C constraints on the partition pin, or

•

A dd LOC constraints to the static logic to minimize routing delays betw een the static logic and the
partition pin.

Because the same static logic implementation is used for every configuration, try to meet timing w ith the
most timing critical reconfigurable modules first. The reconfigurable partition interfaces in this tutorial
are very similar betw een the reconfigurable modules. A global PERIOD constraint is sufficient to meet
reconfigurable partition interface timing.

Adding a PERIOD Constraint
To add a PERIOD constraint:
1.

Open the Timing Constraints w indow (Window > Timing Constraints) in the N etlist Design
w indow .

2.

In the Timing Constraints w indow , right click and select N ew Timing Constraint.

3.

In the N ew Timing Constraint tool, under the Basic group (TN M ) category, set the follow ing values:
•

Group name
clk_p

•

Group type
N et

•

TN M type
TN M _N ET

•

Predefined group
Leave blank

•

N et
clk_p

4.

Click OK.

5.

Re-open the N ew Timing Constraint tool.
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6.

Under the TimeSpec period category, set the follow ing values:
•

TimeSpec name
TS_clk_p

•

Period
5 ns

7.

Click the Browse icon (

) next to Group.

8.

Choose User D efined in the Group constraints type field.

9.

Set clk_p in the User defined groups field, and click OK.

10. Click OK again to create the constraint.
The Timing Constraint w indow now looks like the follow ing figure (Timing Constraints View -pblock_U1_RP_Bram).
This global timing constraint constrains all synchronous paths connected to clk_p. This timing
constraint is not specific to the reconfigurable partition interface.

Figure 16: Timing Constraints View -- pblock_U1_RP_Bram
11. Save the design.
12. N avigate back to the Project M anager to view the UCF.
The follow ing constraints are now included in the constraint file.
•

TIM ESPEC TS_clk_p = PERIOD “ clk_p” 5 ns;

•

N ET “ clk_p” TN M _N ET = “ clk_p” ;

If the UCF is still open from previous steps, select Reload to reload the modified file.
Partial Reconfiguration Tutorial
UG747 (v 13.3) October 19, 2011

www.xilinx.com

27

Step 8: Running Partial Reconfiguration Design Rule Checks

Step 8: Running Partial Reconfiguration Design Rule Checks
You must follow many design rules specific to partial reconfiguration in order to implement a valid
design. Some of these rules have been incorporated in the Design Rule Check (DRC) engine under the
Partial Reconfig and Partition headings.
Run these checks on the partial reconfiguration design before implementing configurations and
generating BIT files.
On a typical design, you might w ant to run all PlanA head DRCs. This tutorial runs only the Partial
Reconfig and Partition DRC.

Running the Partial Reconfiguration and Partition DRCs
To run the partial reconfiguration and partition DRCs:
1.

From the Flow N avigator, select Run D RC, located under the N etlist Design.

Figure 17: Run DRC
2.

From the Run DRC dialog box, select the Partition and Partial Reconfig rules and click OK to run the
selected DRC rules.

Figure 18: Partition and Partial Reconfig DRCs
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Review the Severity of the messages returned by the DRC. The messages can have a Severity of:
•

A dvisory

•

Warning

•

Error

•

Fatal

In this case, the w orst Severity returned is a Warning.

Figure 19: DRC Results
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Step 9: Implementing and Promoting a Configuration
A lthough each reconfigurable partition can have multiple reconfigurable modules associated w ith it, only
one reconfigurable module can be implemented at any one time for the reconfigurable partition.
The set of active reconfigurable modules along w ith static logic is called a configuration and is a complete
design. M ultiple configurations exist for a partial reconfiguration project to allow different permutations
of reconfigurable modules to be implemented, thus generating full and partial BIT files. Each
configuration is its ow n independent implementation run.
The resulting output files are:
•

•

Format files
•

N GD

•

N GM

•

N CD

•

PCF

Report files

You can run Xilinx softw are tools and debug techniques on each configuration individually, such as
opening an N CD w ith FPGA Editor or performing a gate-level simulation.
The design in this tutorial can be fully implemented w ith only tw o configurations using these
reconfigurable module sets and resulting BIT files:
Configuration
------------config_1 RMs: BramFirst, CountCW
Bits: config_1.bit (full bit file)
config_1_U1_RP_Bram_BramFirst_partial.bit
config_1_U2_RP_Count_CountCW_partial.bit
config_2 RMs: BramSecond, CountCCW
Bits: config_2.bit (full bit file)
config_2_U1_RP_Bram_BramSecond_partial.bit
config_2_U2_RP_Count_CountCCW_partial.bit

In summary:
•

The full BIT file config_1.bit contains reconfigurable modules BramFirst and CountCW.

•

The full BIT file config_2.bit contains reconfigurable modules BramSecond and CountCCW.

Tw o other configuration sets can generate unique, full BIT files. H ow ever, because they reuse modules
previously implemented, the partial BIT files are identical to the partial BIT files generated in the
configurations above.
Configuration
------------config_3 RMs: BramFirst, CountCCW
Bits: config_3.bit (full bit file)
config_3_U1_RP_Bram_BramFirst_partial.bit
config_3_U2_RP_Count_CountCCW_partial.bit
config_4 RMs: BramSecond, CountCW
Bits: config_4.bit (full bit file)
config_4_U1_RP_Bram_BramSecond_partial.bit
config_4_U2_RP_Count_CountCW_partial.bit
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Finally, if blackbox RM s w ere created, one additional configuration can be implemented to generate the
blanking bitstreams. The full bit file w ill contain no logic for blackbox RPs, and the partial bit files can be
used to blank an RP.
Configuration
------------config_5 RMs: BramBB, CountBB
Bits: config_3.bit (full bit file)
config_3_U1_RP_Bram_BramBB_partial.bit
config_3_U2_RP_Count_CountBB_partial.bit

The implementation of a configuration in the PlanA head softw are is called a run. A run must be created
for each configuration.
The PlanA head softw are creates a configuration w hen the project is created. The reconfigurable modules
set for this configuration depend on the order in w hich the reconfigurable modules w ere added to the
project. The first reconfigurable module defined for each reconfigurable partition is set for this
configuration (BramFirst and CountCW in the case of this tutorial).
A n FPGA device configured w ith a full BIT file contains the reconfigurable modules that w ere
implemented in the configuration. If the system requires that only the static logic is functioning after
loading the full BIT file, implement a configuration containing black boxes for all reconfigurable
partitions. The resulting partial BIT files are essentially blank files for the reconfigurable partitions.

Implementing Configuration config_1
To implement configuration config_1:
1.

Verify that the reconfigurable modules set for config_1 are BramFirst and CountCW.
a) In the Design Runs w indow (Window > D esign Runs), select config_1.
b) In the Implementation Run Properties w indow , select the Partitions tab. See the figure below .
c)

Ensure that the M odule Variants listed are BramFirst and CountCW.

Figure 20: Configuration Module Variants -- config_1
2.

In the Flow N avigator, click I mplement to launch the implementation run.
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The Design Runs w indow Status field show s w hen N GDBuild, M ap, PA R, and TRA CE are running.
This can also be monitored in the status bar in the upper right-hand corner of the PlanA head
softw are main w indow . For more details about the run status, see the Compilation Log w indow .
3.

Promote the config_1 configuration. From the Flow N avigator, click Promote Partitions.
N ow that config_1 has been successfully implemented, it can be promoted. Running other
configurations w ithout first promoting (then importing) one configuration results in incompatible
partial BIT files among configurations.

Figure 21: Selecting the Promote Partitions Button
4.

In the Promote Partitions dialog box, click OK.
M ake sure the “ A utomatically manage Partition action and import location” option is checked.

5.

Select the Configurations tab. (Select Window > Configurations if not already open.) The Status is
listed as Promoted.

Figure 22: Verifying the Promoted Status
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Step 10: Creating and Implementing Additional
Configurations
To create a new configuration:
1.

From the Flow N avigator, select Create N ew I mplementation Runs from the Implement drop-dow n
list.

Figure 23: Creating New Implementation Runs
2.

In the introduction page of the Create M ultiple Runs w izard, click N ext.

3.

In the Setup Implementation Run page, click N ext.
In the Choose Implementation Strategies and Reconfigurable M odules page, you can create multiple
configurations, choose implementation strategies, and define w hich reconfigurable modules make up
the configurations. There is already a new configuration listed called config_2.

4.

In the Choose Implementation Strategies and Reconfigurable M odules page, leave the new
configuration name as config_2.

5.

Click the button in the Partition A ction column to open the Specify Partition dialog box.
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Figure 24: Create Implementation Runs
The default M odule Variant is based on the reconfigurable modules currently active in the project (in
this case, BramFirst and CountCW). Because these modules have already been implemented and
imported, they are set to I mport and have an import location set.
6.

To create a configuration that implements BramSecond and CountCCW, change the M odule Variant
column to match these reconfigurable modules. See the figure below .
Because these reconfigurable modules have not been implemented (or promoted), the A ction field
changes to I mplement.

Figure 25: Specify Partition Dialog Box -- BramSecond/CountCCW
7.

In the Specify Partition dialog box, click OK.

8.

Optional. If you optionally created Black Box module variants, create an additional configuration to
implement those modules.
a) Click M ore in the Choose Implementation Strategies and Reconfigurable M odules page to add
config_3.
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b) Open the Specify Partition dialog.
c)

Set the M odule Variants to BramBB and CountBB.

d) Click OK.

Figure 26: Specify Partition Dialog Box -- BramBB/CountBB
9.

On the Create Implementation Run page, click N ext.

10. On the Launch Options page, select D o N ot Launch N ow and click N ext.
11. Click Finish on the Create N ew Runs Summary page.
The Design Runs w indow displays the new configurations that w ere created through the w izard.
12. Select a new configuration in the Design Runs w indow .
13. In the Implementation Run Properties w indow , click the Partitions tab to verify the M odule Variants
and A ction fields. The Static logic is set to I mport, and w ill be imported from the promoted results
from config_1.

Figure 27: Verifying Configuration Settings
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14. To launch a configuration:
a) Select one or more configuration in the D esign Runs w indow .
b) Right click and select Launch Runs.
You can launch multiple new configurations in parallel (on multiple processors, if available). The
results are not dependent on each other, but are dependent only on the Static logic from config_1.
15. In the Launch Selected Runs dialog box:
a) Select Launch Runs On Local H ost.
b) Select the number of jobs (number of processors to use).
c)

Click OK.

You may get a Promote Partitions dialog after clicking OK. This is a know n issue and w ill be fixed in
the next release of PlanA head. If you are confident that config_1 has already been promoted, choose
the Launch Run option from this dialog.

Figure 28: Launching Runs
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Step 11: Verifying Configurations
A fter multiple configurations are implemented, you can compare them to verify that the static logic and
partitions pins are consistent across all configurations. Run V erify Configuration to ensure the BIT files
are compatible.

Running Verify Configuration on All Configurations
To run V erify Configuration on all configurations:
1.

From the Flow N avigator, select V erify Configuration from the Program and Debug drop-dow n box.

Figure 29: Verifying Configuration
2.

Select tw o or more configurations to verify against each other.

3.

N ote the value show n for V erification Output File.
M odify this value if necessary as this is the log file for pr_verify. If V erify Configuration fails, this
file w ill be useful for analyzing the results.

3.

Click OK.
If the verification checks pass, the PlanA head softw are reports that no errors w ere found. You may
now generate BIT files.

4.

Click OK.
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Step 12: Generating and Downloading BIT Files
For each configuration, multiple BIT files are generated.
•

One full BIT file that can be used to program the FPGA initially.

•

One partial BIT file for each reconfigurable partition that contains the logic for the module variants
associated w ith the particular configuration. A ny of the partial BIT files can be used to reconfigure
the associated partial reconfiguration regions.

In this tutorial you created configurations w ith:
•

BramFirst

•

CountCW

•

BramSecond

•

CountCCW

•

BramBB (optional)

•

CountBB (optional)

Running BitGen on each configuration creates partial BIT files for all reconfigurable modules. Regardless
of the full BIT file used to configure the device initially, you can use any of the partial BIT files to
reconfigure the associated partial reconfiguration regions.

Generating BIT Files for all Configurations
To generate BIT Files for all configurations:
1.

In the Design Runs w indow :
a) H ighlight all configurations.
b) Right-click.
c)

Select Generate Bitstream.

Figure 30: Generate Bitstream
2.

N o special BitGen options are required to generate partial BIT files. Click OK in the BitGen Options
dialog box to launch BitGen.
The partial BIT files are dow nloaded to the FPGA device in the same manner as full BIT files. You can
use the iM PA CT tool for BIT file dow nloading, verification, and debugging.
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3.

Connect the USB dow nload cable to the M L605 board and the PC.

4.

To start iM PA CT in standalone mode, from the Flow N avigator, select iM PACT from the Program
and Debug drop-dow n box.

Figure 31: Launching iMPACT
5.

In the iM PA CT Flow s frame:
a) Double-click Boundary Scan.
b) Click Initialize Chain.

6.

A fter the chain has been successfully detected:
a) Right-click the xc6vlx240t device.
b) Select Assign N ew Configuration File.
c)

Select the follow ing full BIT file:
<Extract_Dir>/PlanAhead/<project_name>/<project_name>.runs/config_1/config_1.bit

7.

Right-click xc6vlx240t again.
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8.

Select Program.

Figure 32: Configuring the Device through iMPACT
The FPGA device on the M L605 programs w ith the full BIT file.

Associating a Partial BIT File
To associate a partial BIT file:
1.

Right-click the xc6vlx240t device.

2.

Select A ssign N ew Configuration File.

3.

Select the follow ing partial BIT file:
<Extract_Dir>/PlanAhead/<project_name>/<project_name>.runs/config_2/config_2_U1_RP_
Bram_BramSecond_partial.bit

4.

Right-click the xc6vlx240t device again.

5.

Select Program.
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Conclusion
In this tutorial, you did the follow ing:
•

Created a partial reconfiguration project in the PlanA head softw are.

•

Created tw o reconfigurable partitions.

•

A ssociated multiple reconfigurable modules w ith each reconfigurable partition.

•

Constrained each reconfigurable partition to an area of the device using A REA _GROUP constraints.

•

Created global timing constraints to constrain the entire design.

•

Implemented and promoted an initial configuration.

•

Created additional configurations that imported the static logic from the initial configuration.

•

Verified the cohesiveness of all configurations.

•

Generated BIT files.

•

Dow nloaded a full BIT file to the M L605 board containing the BramFirst and CountCW modules.

•

Reconfigured U1_RP_Bram w ith a partial BIT file for the BramSecond module.
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